Version 1 Release 1

IBM Management Console for IMS and Db2 for z/OS
User's Guide

IBM
Before using this information and the product it supports, be sure to read the general information under "Notices" at the end of this information.
## Contents

About this information.............................................................................................................................................. v

### Chapter 1. Management Console overview
- Management Console features and benefits........................................................................................................ 1
- Management Console extensions.......................................................................................................................... 3
- Management Console architecture....................................................................................................................... 3
- Management Console security............................................................................................................................ 5
- Management Console documentation and updates.............................................................................................. 5
- Accessibility features.............................................................................................................................................. 7

### Chapter 2. Installing and starting Management Console
- Software requirements for Windows..................................................................................................................... 9
- Installing Management Console on Windows........................................................................................................ 10
- Starting the Management Console server on Windows......................................................................................... 11
- Updating Management Console on Windows......................................................................................................... 13
- Uninstalling Management Console from Windows............................................................................................... 14
- Software requirements for z/OS.......................................................................................................................... 14
- Installing Management Console on z/OS................................................................................................................ 16
- Starting the Management Console server on z/OS................................................................................................. 18
- Updating Management Console on z/OS................................................................................................................ 20
  - Updating Management Console on z/OS using the IBM product repository..................................................... 21
  - Updating from a local Management Console repository on z/OS................................................................... 22
- Uninstalling Management Console from z/OS....................................................................................................... 24

### Chapter 3. Configuring Management Console
- Configuring Management Console for IMSplex management........................................................................... 25
- Configuring Management Console for autonomic maintenance of IMS databases........................................... 25
- Extending Management Console with IMS Tools products.................................................................................. 26
  - Viewing DBD and PSB maps in Management Console...................................................................................... 26
  - Configuring Management Console for Db2 for z/OS administration............................................................... 27

### Chapter 4. Managing autonomic IMS database evaluations

### Chapter 5. Tutorial: Managing IMS databases by exception
- Lesson 1: Organizing your view with the IMS databases that you frequently work with..................................... 31
- Lesson 2: Finding and identifying IMS database problems................................................................................. 32
- Lesson 3: Viewing an IMS database exception.................................................................................................. 33

### Chapter 6. Troubleshooting
- Gathering diagnostic information.......................................................................................................................... 35
- Messages for Management Console..................................................................................................................... 36
  - AIIAC0002E..................................................................................................................................................... 36
  - AIIAC0003I..................................................................................................................................................... 36
  - AIIAC0004E..................................................................................................................................................... 36
  - AIIAC0006I..................................................................................................................................................... 37
  - AIIAC0008I..................................................................................................................................................... 37
  - AIIAC0010I..................................................................................................................................................... 37
  - AIIAC0011E..................................................................................................................................................... 37
  - AIIAC0012I..................................................................................................................................................... 38
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notices</td>
<td>43</td>
</tr>
<tr>
<td>Trademarks</td>
<td>44</td>
</tr>
<tr>
<td>Terms and conditions for product documentation</td>
<td>45</td>
</tr>
<tr>
<td>Privacy policy considerations</td>
<td>45</td>
</tr>
<tr>
<td>Index</td>
<td>47</td>
</tr>
</tbody>
</table>
IBM Management Console for IMS and Db2 for z/OS (Management Console) consolidates system health information and autonomic capabilities from various products on z/OS into a single, intuitive graphical interface.

These topics provide instructions for installing, configuring, and using Management Console.

These topics are designed to help database administrators, system programmers, application programmers, and system operators perform these tasks:

• Plan for the installation of Management Console
• Install and operate Management Console
• Customize your Management Console environment
• Diagnose and recover from Management Console problems
• Use Management Console with other Db2 or IMS products

For the most current version of this information, always check the IMS Tools Product Documentation page.
Chapter 1. Management Console overview

IBM Management Console for IMS and Db2 for z/OS (Management Console) is an application server that consolidates information about your IMS and Db2 for z/OS into a single, intuitive, graphical web interface. This interface is used on a client to connect to different services on z/OS. Management Console can accelerate your analysis of your z/OS environment and reduce the need for advanced mainframe skills.

You can use Management Console to manage automated database evaluations and monitor IMS and Db2 for z/OS resources across an enterprise. You can view aggregate statistics for groups of resources and detailed information for individual resources. You can use this information to identify resources that require your attention and to prevent problems.

The information in Management Console is gathered from various sources, including IBM Tools Base for z/OS components, IMS Tools products, Db2 Tools for z/OS products, IMS Operations Manager, and other sources.

Management Console features and benefits

IBM Management Console for IMS and Db2 for z/OS (Management Console) provides solutions for database administration and monitoring challenges.

Management Console helps you complete essential tasks for IMS and Db2 for z/OS administration.

Features for IMS administration

Connect Management Console to your IMS environment and discover and manage your IMSplex resources

You can define a connection between Management Console and IMS Connect so that Management Console can discover information about your IMSplex resources. After a connection to IMS Connect is created, Management Console provides you information about your IMSplex installations and related IMS Connect installations, IMS databases, programs, routing codes, and transactions.

After a connection to IMS Connect is created, you have access to the following capabilities:

• View the status for resources such as related Open Transaction Manager Access (OTMA), Open Database Manager (ODBM), IMS Connect, IMS structures, IMS regions, and recovery control (RECON) data sets.
• Start and stop the communication with most of these resources.
• View IMS resources and update programs, transactions, databases, and routing codes.
• Issue IMS commands that are supported by the Operations Manager (OM) API, and examine the command result in either text or grid mode.
• Run multiple IMS commands simultaneously from a batch file, and examine the results.
• View transactions, programs, databases, and routing codes as repository resources at the IMSplex level.

Manage autonomic IMS database evaluations.

Management Console integrates with IBM Tools Base Autonomics Director for z/OS (Autonomics Director) to give you control over the autonomic settings for your environment. You can designate which databases receive automatic evaluations by adding databases to monitor lists, and you can schedule the evaluations around your processing demands by managing schedules. With Management Console, you have access to an intuitive interface for automating routine database monitoring tasks.

Provides comprehensive and customizable views of all IMS environments across your enterprise.

You can view statistics for IMS databases from any of your IMS environments within a single Management Console session. You can create custom groups of databases and view summary health statistics about all of the databases in a group. You can then drill down to display detailed statistics for specific databases, including exceptions, reports, and historical graphs.
View IMS database exceptions.
These exceptions are generated when database states cross thresholds that are specified in policies that you define in IBM Tools Base Policy Services for z/OS (Policy Services). The ability to define a custom set of policies in Policy Services and use Management Console to monitor exceptions to those policies means that you will be notified before any of your monitored databases experience disruptions. This ability helps you to focus on those databases that need your attention and eliminate unnecessary manual analysis and routine preemptive tuning.

View recommendations to help you address certain types of IMS database exceptions.
Automatic recommendations are built from the integration with Policy Services and Autonomics Director. These recommendations reduce some of the overhead that is otherwise required to analyze a problem, so you can move more quickly from a potential problem to a resolution.

Access reports that are generated by many IBM IMS Tools products and that are stored in the IBM Tools Base IMS Tools Knowledge Base for z/OS repository.
You can search for reports by using a variety of search criteria including database name, job name, report name, or completion code. You can save frequently used search criteria.

Extend the core functionality of Management Console with extensions from other IMS Tools products.
For example, the DBD/PSB Map Viewer extension visualizes the structure of IMS databases and programs and helps you analyze the database descriptions (DBDs) and program specifications (PSBs) visually.

Use a robust integrated help system that describes how to use Management Console and includes relevant IMS reference information.
DBAs who are less familiar with IMS can use this information to shorten their IMS learning curve.

Features for Db2 for z/OS administration
Connect Management Console to your Db2 for z/OS environment and discover your Db2 resources
You can define a connection between Management Console and Db2 for z/OS so that Management Console can obtain, or discover, information about your Db2 resources. After the discovery is complete, you can navigate to information about your Db2 resources in Management Console by searching or browsing.

You can view properties for the following types of Db2 resources:
• Subsystems
• Data sharing groups
• Databases
• Table spaces
• Table space partitions
• Indexes spaces
• Index space partitions
Additionally, you can view graphical charts of Db2 real-time statistics for the following types of Db2 resources:
• Table spaces. If a table space is partitioned, charts are available only for the table space partitions.
• Index spaces. If an index space is partitioned, charts are available only for the index space partitions.

Use a robust integrated help system that describes how to use Management Console and includes relevant Db2 reference information.
DBAs who are less familiar with Db2 can use this information to shorten their Db2 learning curve.

Related concepts
Management Console architecture
The application server for IBM Management Console for IMS and Db2 for z/OS (Management Console) can be installed on Windows or z/OS. Management Console can then connect to z/OS through Secure Socket Layer (SSL) TCP/IP connections.

Management Console security
Only authorized users can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to access z/OS systems. Management Console also provides secure communication between distributed clients and the z/OS systems that they are connected to.

Management Console extensions
Extensions from other products provide enhancements to IBM Management Console for IMS and Db2 for z/OS (Management Console).

Table 1. Management Console extension

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
<th>Tasks enabled</th>
<th>Provided by</th>
</tr>
</thead>
</table>
| DBD/PSB Map Viewer      | Provides a graphical visualization of a database structure map, program specifications, the DBD and PSB macro source, and the DBD and PSB XML document that is generated based on the database description (DBD) in the IMS.DBDLIB or IMS.PSBLIB library | • View the structure of the database and programs and graphically analyze the relationship between segments.  
• Save the graphical view of the database structure or program in an HTML file and view it locally or share it with your team.  
• Examine the control statements that were used as input to the DBDGEN utility or the PSBGEN utility to define the database, program, and its characteristics. You can view all the control statements that were used for defining the database, programs, data sets, and segments.  
• View the DBD and PSB in XML format.  
• Identify the relation between DBDs and logical DBDs, and DBDs and PSBs. | IMS Library Integrity Utilities of IMS Database Solution Pack and IMS Fast Path Solution Pack |

Management Console architecture
The application server for IBM Management Console for IMS and Db2 for z/OS (Management Console) can be installed on Windows or z/OS. Management Console can then connect to z/OS through Secure Socket Layer (SSL) TCP/IP connections.

The following figure illustrates a typical Management Console environment:
Figure 1. Typical Management Console environment

The Management Console architecture consists of the following elements:

- A client machine with Internet connectivity and a supported web browser. The client connects to the Management Console server by using HTTP or HTTPS.
- The Management Console web server, which can be installed on a Windows workstation, a Windows server, or z/OS.
- A connection interface that provides access to z/OS resources, such as one of the following:
  - Distributed Access Infrastructure, which runs on z/OS. This component provides distributed clients access to IMS and IMS Tools through a centrally controlled standard TCP/IP socket.
  - IMS Connect, which runs on z/OS. IMS Connect allows access to the IMS Operations Manager component of an IMSplex via a TCP/IP socket connection.
  - Db2 distributed data facility (DDF), which is part of Db2 for z/OS. DDF provides TCP/IP access to Db2 data.

You can connect to any number of these interfaces from the same Management Console web server.

- Any of the following products and components that integrate with Management Console:
  - IMS
  - IBM Tools Base Autonomics Director for z/OS
  - IBM Tools Base Policy Services for z/OS
  - IBM Tools Base IMS Tools Knowledge Base for z/OS
  - IBM IMS Database Solution Pack for z/OS
  - IBM IMS Fast Path Solution Pack for z/OS
  - Db2 for z/OS
  - Db2 Utilities Solution Pack
Management Console security

Only authorized users can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to access z/OS systems. Management Console also provides secure communication between distributed clients and the z/OS systems that they are connected to.

Transport Layer Security (TLS) and Secure Sockets Layer (SSL) connections

During the Management Console installation, you specify whether you want Management Console to support a secure connection (HTTPS), a non-secure connection (HTTP), or both. By using HTTPS, TCP/IP connections between distributed clients and the Management Console server use TLS or SSL to prevent other users from accessing any of your TCP/IP communications.

For securing connections between the Management Console server and Distributed Access Infrastructure, you can use AT/TLS to enable SSL.

For more information about Distributed Access Infrastructure and SSL, see Tools Base Distributed Access Infrastructure in IMS Database Solution Pack for z/OS documentation.

For securing connections between the Management Console server and IMS Connect, you can use AT/TLS to enable SSL. The integrated SSL feature in IMS Connect is not supported. You must use AT/TLS.

Authentication and authorization

Users log in with a user ID and password that is specific to Management Console and assigned by an administrator. After logging in, users must provide a valid RACF® (or SAF equivalent) user ID and password whenever they use Management Console to view data or edit settings that reside on z/OS.

Firewalls

You might need to configure the firewall in your organization to allow Management Console to communicate with z/OS. Communication must be enabled between the client web browser and the Management Console application server, as well as between the application server and z/OS. Depending on the location of the firewall, you must either open the port for the application server or for the TCP server on z/OS.

For communication between the web browser and the application server, the port number is specified during the Management Console installation. The default port number for HTTP is 9080, and the default port number for HTTPS is 9443.

For communication between the application server and Distributed Access Infrastructure, the port number is specified during the Distributed Access Infrastructure TCP server configuration. The default port number is 5123.

For communication between the application server and IMS Connect, the port number is specified in the IMS Connect configuration member of the IMS.PROCLIB data set.

Management Console documentation and updates

IMS Tools information is available at multiple places on the web. You can receive updates to IMS Tools information automatically by registering with the IBM My Support service.

Contents

• “Management Console documentation on the web” on page 6
• “Receiving documentation updates automatically” on page 6
• “Known issues and workarounds” on page 6
Management Console documentation on the web

The IMS Tools Product publications web page provides current product documentation that you can view, print, and download. To locate publications with the most up-to-date information, refer to the following web page:

http://www-01.ibm.com/support/docview.wss?uid=swg27020942

You can also access documentation for many IMS Tools and Db2 Tools for z/OS from IBM Knowledge Center:

http://www.ibm.com/support/knowledgecenter

IBM Redbooks® publications that cover IMS Tools are available from the following web page:

http://www.redbooks.ibm.com

The Data Management Tools Solutions website shows how IBM solutions can help IT organizations maximize their investment in IMS databases while staying ahead of today's top data management challenges:


Receiving documentation updates automatically

To automatically receive a weekly email that notifies you when new technote documents are released, when existing product documentation is updated, and when new product documentation is available, you can register with the IBM My Support service. You can customize the service so that you receive information about only those IBM products that you specify.

To register with the My Support service:

2. Enter your IBM ID and password, or create one by clicking register now.
3. On the My Support page, click add products to select the products for which you want to receive information updates.
4. Click Subscribe to email to specify the types of updates that you want to receive.
5. Click Update to save your profile.

Known issues and workarounds

At the time of publication, the following issues were known.

<table>
<thead>
<tr>
<th>Table 2. Known issues and workarounds</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Issue description</strong></td>
</tr>
<tr>
<td>When setting up a new environment, you must provide the hostname, port, and IMSplex for the IMS Connect. The Validate button is not highlighted even after providing values for the required fields.</td>
</tr>
</tbody>
</table>
Table 2. Known issues and workarounds (continued)

<table>
<thead>
<tr>
<th>Issue description</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the command console, if you issue a type-1 command or select a batch file and click <strong>Grid View</strong>, a dialog message similar to the following displays: The IMS type-1 command and batch file results cannot be displayed in a grid view.</td>
<td>Click anywhere on that page to deselect the <strong>Grid View</strong> button.</td>
</tr>
<tr>
<td>After this dialog is closed, the <strong>Grid View</strong> button is still highlighted along with the <strong>Text View</strong> button.</td>
<td></td>
</tr>
</tbody>
</table>

**Accessibility features**

Accessibility features help a user who has a physical disability, such as restricted mobility or limited vision, to use a software product successfully.

The tools that are used by Management Console provide standard TSO/ISPF interfaces alternatives to the Management Console interface. The ISPF editor provides keyboard-only operation. For information about navigating the ISPF panels by using TSO/E or ISPF, refer to the following publications for information about accessing ISPF interfaces:

- z/OS ISPF User's Guide, Volume 1, SC34-4822
- z/OS TSO/E Primer, SA22-7787
- z/OS TSO/E User's Guide, SA22-7794

These guides describe how to use ISPF, including the use of keyboard shortcuts or function keys (PF keys), include the default settings for the PF keys, and explain how to modify their functions.

See the IBM Human Ability and Accessibility Center at [http://www.ibm.com/able/](http://www.ibm.com/able/) for more information about the commitment that IBM has to accessibility.
Chapter 2. Installing and starting Management Console

Before you can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to manage your resources, you must install Management Console.

The Management Console server is a central web server. Only a single instance of the server is required because it supports simultaneous log-in for all Management Console users.

The installation of Management Console installs a web server that serves up the Management Console web pages that make up the Management Console user interface and also communicates with your back-end host systems.

Installing on Windows is simpler than installing on z/OS. You might want to install Management Console in Windows to sample the features before you require Management Console to be installed on z/OS.

The SMP/E on z/OS process for installing Management Console onto a z/OS system must be completed regardless of whether you intend to install Management Console on Windows or z/OS. This is because the Management Console repository, which is used by Installation Manager to install Management Console on Windows or z/OS is only available on shopZ as an SMP/E part. Regardless of whether you will be installing Management Console on Windows or z/OS, you must complete the SMP/E installation of Management Console and run the DYWZCOPY sample job (one of the parts installed by SMP/E) to copy the installation repository from the data set where it is installed my SMP/E to a file system where it can be accessed by Installation Manager.

You can install the Management Console on Windows or z/OS. In the sections that follow, separate installation instructions are provided for the two platforms on which Management Console can be installed, Windows and z/OS:

Software requirements for Windows

Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

- Windows 7 or later (32-bit) or Windows 7 or later (64-bit) is required.
- The SMP/E installation process for Management Console must be complete, meaning that the separate parts of the Management Console repository are copied into a target data set. For instructions, see Program Directory for IBM Management Console for IMS and Db2 for z/OS (GI10-9007).
- After the SMP/E installation process completes, the DYWZCOPY job must be run.

The DYWZCOPY job makes the Management Console repository accessible to Installation Manager, by completing the following actions:

1. Allocates and mounts a z/OS File System (zFS) or Hierarchical File System (HFS)
2. Copies and combines the separate parts of the Management Console repository into the zFS or HFS file system, from the data set where SMP/E placed it.
3. Sets permissions on the Management Console repository.

- Installation Manager version 1.8 or later
- One of the following web browsers:
  - Mozilla Firefox ESR 31 or later
  - Google Chrome 36 or later
User requirements for Windows
To install Management Console on Windows, the user ID under which Management Console will be installed and will run, must have the level of permissions that will allow it to install software on Windows and will allow that software to communicate with your host systems via TCP/IP.

Related tasks
“Installing Management Console on Windows” on page 10
You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on Windows using Installation Manager.

“Starting the Management Console server on Windows” on page 11
The Management Console user interface is accessed through web pages on the Management Console server. The Management Console server must be started and then configured in order to connect to your back-end z/OS systems to be managed.

“Updating Management Console on Windows” on page 13
This task guides you through updating Management Console from IBM-hosted product repository for Management Console.

“Uninstalling Management Console from Windows” on page 14
You can uninstall IBM Management Console for IMS and Db2 for z/OS (Management Console) from Windows by using IBM Installation Manager.

Installing Management Console on Windows
You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on Windows using Installation Manager.

Before you begin
1. Make sure your system meets the minimum requirements that are described in Software requirements for Windows.
2. Install Installation Manager if you do not have it already installed on the machine where you will be installing Management Console. For more information, see: Installing Installation Manager on Windows.
3. Ensure that the SMP/E installation process for Management Console has completed successfully.
4. Transfer the Management Console repository from the location on z/OS where the DYWZCOPY job places it to your preferred location, by using FTP or a similar file transfer utility. (The DYWZCOPY must be run after the Management Console SMP/E installation on z/OS has completed successfully.) Ensure that you transfer the file in binary mode. The installation repository must be accessible to the Windows workstation or server where you install Management Console.

Procedure
Complete the following steps to install Management Console on Windows:
1. Ensure that any files that remain in the installation directory from a prior installation are removed.
2. Start Installation Manager from the Windows Start menu. You must run Installation Manager on the Windows workstation that you are installing Management Console on.
3. In the Installation Manager interface, click File > Preferences > Repositories and then click Add Repository. In the Add Repository window, take one of the following actions: Close the Preferences window by clicking OK.
   - Specify the path to the Management Console installation repository that you transferred in the first step to your preferred location that is accessible to your Windows system, and click OK.
   - Point your repository preferences to the local copy of the Management Console repository that was created by the DYWZCOPY job, as described in “Software requirements for Windows” on page 9.
4. Click Install.
5. Select **IBM Management Console for IMS and DB2 for z/OS** and the version that you want to install, for example **Version 1.1.0.4** and click **Next**. There may be only a single repository version shown if you only added and enabled a single repository in **File > Preferences > Repositories**.

6. Complete the installation by following the instructions in the Installation Manager interface.

On the Web server customization panel, select whether to enable an HTTP port, an HTTPS port, or both. Select an HTTPS port in most cases, unless the Management Console server and the browsers that access it run behind the safety of a firewall, or you plan to access Management Console only from a browser that runs locally where the Management Console server is installed.

**Tip:** If Management Console is configured to use an HTTPS port, you might encounter a warning or error message about a self-signed certificate when you first access Management Console from a web browser. Management Console uses a self-signed SSL certificate to authenticate communication between your web browser and Management Console. You can confirm that the certificate is self-signed by IBM and bypass the warning message in your browser. You might also be able to permanently accept the warning messages by adding the certificate to your browser's trusted certificates, so that it does not display each time that you connect. For detailed information about handling certificate warnings, see the help for your web browser.

Alternatively, you can use a certificate authority to create a different certificate that is not self-signed, and import that certificate into Management Console.

**Tip:** The port number becomes part of the address that you use to access Management Console from your supported web browser. The default port number for HTTP is 9080, and the default port number for HTTPS is 9443.

**What to do next**
Start the Management Console server. For more information, see **Starting the Management Console server on Windows**.

**Related concepts**
“Management Console security” on page 5
Only authorized users can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to access z/OS systems. Management Console also provides secure communication between distributed clients and the z/OS systems that they are connected to.

**Related tasks**
“Updating Management Console on Windows” on page 13
This task guides you through updating Management Console from IBM-hosted product repository for Management Console.

“Uninstalling Management Console from Windows” on page 14
You can uninstall IBM Management Console for IMS and Db2 for z/OS (Management Console) from Windows by using IBM Installation Manager.

**Related reference**
“Software requirements for Windows” on page 9
Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

---

**Starting the Management Console server on Windows**

The Management Console user interface is accessed through web pages on the Management Console server. The Management Console server must be started and then configured in order to connect to your back-end z/OS systems to be managed.

**Before you begin**
Ensure that you use of the following supported web browsers:

- Mozilla Firefox ESR 31 or later
About this task
A Management Console administrator user profile must be created by accessing the Management Console log-in page as the first user. With administrator privileges, a user can define user IDs and passwords for other Management Console users.

Procedure
1. Start the Management Console server from the Windows Start menu by clicking IBM Management Console for IMS and DB2 for zOS > Start Management Console Web Server. A DOS window provides information about the server start process. The following message indicates that the Management Console server is started successfully:

   The server IMAC is ready to run a smarter planet.

Important: Do not close the DOS window. Closing the window stops the web server.
2. Open the Management Console user interface by taking one of the following actions:
   • Open the following address in a browser window, and log in:

```
<http|https>://<hostname:port>/imweb/common/login.html
```

   where:

- `<http or https>`
  Depends on whether HTTP or HTTPS ports were enabled during installation.

- `<host name or IP address>`
  The name of the server that is hosting Management Console.

- `<port number>`
  The port number that was specified when Management Console was installed. The default port number for HTTP is 9080, and the default port number for HTTPS is 9443.

   This method works from any supported web browser that can connect to the server that is hosting Management Console.

- In Windows where you installed the Management Console sever, click Start > IBM Management Console for IMS and DB2 and zOS > Login Pages and select Open HTTPS Login Page or Open HTTP Login Page, depending on which ports were enabled during the install.

   The first time that you log into a Management Console server instance, you have administrator privileges, which allow you to create other user IDs.

   Tip: If Management Console is configured to use an HTTPS port, you might encounter a warning or error message about a self-signed certificate when you first access Management Console from a web browser. Management Console uses a self-signed SSL certificate to authenticate communication between your web browser and Management Console. You can confirm that the certificate is self-signed by IBM and bypass the warning message in your browser. You might also be able to permanently accept the warning messages by adding the certificate to your browser's trusted certificates, so that it does not display each time that you connect. For detailed information about handling certificate warnings, see the help for your web browser.

Related concepts
“Management Console security” on page 5
Only authorized users can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to access z/OS systems. Management Console also provides secure communication between distributed clients and the z/OS systems that they are connected to.

Related tasks
“Updating Management Console on Windows” on page 13
This task guides you through updating Management Console from IBM-hosted product repository for Management Console.

**Related reference**

“Software requirements for Windows” on page 9

Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

## Updating Management Console on Windows

This task guides you through updating Management Console from IBM-hosted product repository for Management Console.

**Procedure**

1. Stop the Management Console server.
2. Start Installation Manager from the Windows **Start** menu. You must run Installation Manager on the Windows environment that you are installing Management Console on.
3. In the Installation Manager interface, click **File** > **Preferences** and then click **Add Repository**. Then specify the location of the Management Console repository by taking one of the following actions:
   - Specify the following path which points to the latest Management Console repository in the remote IBM product repository:
     
   
   **Tip:** If you have not saved your credentials in the Installation Manager secure storage, Installation Manager displays a pop-up window and asks you for your IBM ID and password in order to access the IBM product repository. Information about saving your credentials in the Installation Manager secure storage can be found under “Security considerations for Installation Manager” in the Installation Manager help. When setting your Secure Storage preferences in **File** > **Preferences**, be sure to select the “Use master password” check-box and set the master password (click “Change Password”) in order to encrypt your credentials in the **File** > **Preferences** Secure Storage file which will cause your credentials in Installation Manager Secure Storage to be encrypted.
   - Point your repository preferences to the local copy of the Management Console repository on z/OS where the DYWZCOPY job placed it.
4. Close the **Add Repository** window by clicking **OK**, and close the **Preferences** window by clicking **OK**.
5. Click **Update**.
6. Select **IBM Management Console for IMS and DB2 for z/OS** and the package version that you want to update Management Console to. Then, click **Next**.

**Related tasks**

“Installing Management Console on Windows” on page 10

You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on Windows using Installation Manager.

“Starting the Management Console server on Windows” on page 11

The Management Console user interface is accessed through web pages on the Management Console server. The Management Console server must be started and then configured in order to connect to your back-end z/OS systems to be managed.

“Uninstalling Management Console from Windows” on page 14

You can uninstall IBM Management Console for IMS and Db2 for z/OS (Management Console) from Windows by using IBM Installation Manager.

**Related reference**

“Software requirements for Windows” on page 9
Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

Uninstalling Management Console from Windows

You can uninstall IBM Management Console for IMS and Db2 for z/OS (Management Console) from Windows by using IBM Installation Manager.

**Procedure**

1. Stop Management Console.
2. Start Installation Manager from the Windows **Start** menu. You must run Installation Manager on the Windows server or workstation that Management Console is installed on.
3. In the Installation Manager interface, click **Uninstall**.
4. In the **Uninstall Packages** window, select IBM Management Console for IMS and Db2 for z/OS, and click **Next**.
5. Click **Uninstall**.

**Related tasks**

- “Installing Management Console on Windows” on page 10
- “Starting the Management Console server on Windows” on page 11
- “Updating Management Console on Windows” on page 13

**Related reference**

- “Software requirements for Windows” on page 9

Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

Software requirements for z/OS

Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

The system requirements describe the supported z/OS software requirements for Management Console. Ensure that you are familiar with the minimum product levels that you must install before you open a problem report.

- z/OS V01.13.00 or V02.01.00 or later and IBM Java JRE 7.1 or later 64-bit
- The SMP/E installation process for Management Console must be complete, meaning that the separate parts of the Management Console repository are copied into a target data set. For instructions, see *Program Directory for IBM Management Console for IMS and Db2 for z/OS (GI10-9007).*
- Installation Manager version 1.8 or later
- One of the following web browsers:
  - Mozilla Firefox ESR 31 or later
  - Google Chrome 36 or later
User requirements for z/OS

Installing Management Console involves multiple user responsibilities. Before you begin to install, ensure that all required users have the correct access and security permissions. A System Administrator or Security Administrator is required to create or modify the RACF profile for the user ID under which the Management Console started task will run. A z/OS UNIX System Services Administrator will be required to obtain the disk space required for the installation of Management Console. A System or z/OS UNIX System Services Administrator may be required to modify and submit the JCL jobs to create the required file systems, copy the repository into the appropriate file system, and install Management Console.

The user ID, or the group that the user ID belongs to, that is installing Management Console needs to have access to the following profiles in the RACF FACILITY and UNIXPRIV classes:

FACILITY:

BPX.FILEATTR.APF READ
BPX.FILEATTR.PROGCTL READ
BPX.FILEATTR.SHARELIB READ

UNIXPRIV:

SUPERUSER.FILESYS.CHOWN READ
SUPERUSER.FILESYS.CHANGEPERMS READ

During the installation process, you will need to work with the people who:

- are responsible for setting-up and running the started task to start the Management Console,
- control access to RACF FACILITY classes, and
- control access to UNIX privileges.

Related tasks

- “Installing Management Console on z/OS” on page 16
  You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

- “Starting the Management Console server on z/OS” on page 18
  A Management Console user must create an administrator user profile by accessing the Management Console log in page as the first user. A user who has administrator privileges can define user IDs and passwords for other Management Console users.

- “Updating Management Console on z/OS” on page 20
  As updates for IBM Management Console for IMS and Db2 for z/OS (Management Console) become available, you can install the latest package by running the Management Console installation job.

- “Updating Management Console on z/OS using the IBM product repository” on page 21
  You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRED job.

- “Updating from a local Management Console repository on z/OS” on page 22
  You can install a Management Console package that is obtained through SMP/E by running theDYWZINS job. This job uses Installation Manager to install the package from the Installation Manager repository on your z/OS system.

- “Uninstalling Management Console from z/OS” on page 24
You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

## Installing Management Console on z/OS

You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

### Before you begin

- Make sure your system meets the minimum requirements that are described in Software requirements for z/OS.
- Install Installation Manager if you do not have it already installed on the machine where you will be installing Management Console. For more information, see: Installing Installation Manager on z/OS.
- Ensure that the SMP/E installation process for Management Console has completed successfully.

### About this task

You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation and use Installation Manager to install the Management Console server in a z/OS UNIX System Services file system.

Use the following sample jobs to install and run the Management Console server on z/OS:

### Table 3. Sample jobs for installing and running Management Console on z/OS

<table>
<thead>
<tr>
<th>Job</th>
<th>Description</th>
</tr>
</thead>
</table>
| DYWZCOPY | The DYWZCOPY job makes the Management Console repository accessible to Installation Manager, by completing the following actions:  
1. Allocates and mounts a z/OS File System (zFS) or Hierarchical File System (HFS)  
2. Copies and combines the separate parts of the Management Console repository into the zFS or HFS file system, from the data set where SMP/E placed it.  
3. Sets permissions on the Management Console repository. |
| DYWZCFS  | Allocates and mounts a new zFS or HFS file system into which Management Console is installed by Installation Manager. |
| DYWZINS  | Installs Management Console by using Installation Manager. |
| DYWZRACF | Authorizes Management Console to run as an MVS™ started task. |
Table 3. Sample jobs for installing and running Management Console on z/OS (continued)

<table>
<thead>
<tr>
<th>Job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYWZSRV</td>
<td>Starts Management Console as an MVS started task. This procedure must be</td>
</tr>
<tr>
<td></td>
<td>authorized to the STARTED class of your system authorization facility (SAF)</td>
</tr>
<tr>
<td></td>
<td>settings. DYWZRACF is provided to authorize the procedure.</td>
</tr>
</tbody>
</table>

**Procedure**

Complete steps 1 and 2 to create the zFS or HFS file system that contains the Management Console repository.

1. Modify the DYWZCOPY job for your environment by following the instructions in the comments of the DYWZCOPY job. The the zFS or HFS directory where you want to copy the Management Console repository, comment out the CREATE step.

2. Submit the DYWZCOPY job and verify that it completes with a condition code of 0.

   **Troubleshooting tip:** If the job fails because the value that is specified for the -owner or -group option is incorrect, the file system might be created, but it might be unusable. To fix this problem, unmount and delete the data sets that you created, correct the -owner or -group option value, and then run the DYWZCOPY job again.

The DYWZCOPY job makes the Management Console repository accessible to Installation Manager, by completing the following actions:

   a. Allocates and mounts a z/OS File System (zFS) or Hierarchical File System (HFS)
   b. Copies and combines the separate parts of the Management Console repository into the zFS or HFS file system, from the data set where SMP/E placed it.
   c. Sets permissions on the Management Console repository.

Complete steps 3 and 4 to create the zFS or HFS file system that Management Console is installed into:

3. Modify the DYWZCFS job for your environment by following the instructions in the comments of the DYWZCFS job.

4. Submit the DYWZCFS job and verify that it completes with condition code of 0.

   **Troubleshooting tip:** If the job fails because the value that is specified for the -owner or -group option is incorrect, the file system might be created, but it might be unusable. To fix this problem, unmount and delete the data sets that you created, correct the -owner or -group option value, and then run the DYWZCFS job again.

Complete steps 5 thru 7 to install Management Console with Installation Manager:

5. Modify the DYWZINS job for your environment by following the instructions in the comments of the DYWZINS job.

6. Ensure that any files that remain in the installation directory from a prior installation are removed, and then submit the DYWZINS job.

7. Submit the DYWZINS job and verify that it completes with a condition code of 0.

   **Troubleshooting tip:** To view the Management Console license information, see IBM Software license agreements.

Verify the output to ensure that the installation is successful. If the installation is successful, the DYWZINS job log typically contains the following lines at the end of the log:

- Cleaning up saved files.
- Validating eclipse configuration for IBM Management Console for IMS and DB2 for z/OS
- Modified com.ibm.imac_1.1.0.yyyymmdd_hhmm to the /usr/lpp/IBM/mgmtconsole/v110 directory.
Logs for product installation can be found in the logs sub-directory of the location where Installation Manager stores run time data. For example, the location might be `/usr/lpp/InstallationManager/appdata/logs`.

**What to do next**
Start the Management Console server. For more information, see Starting the Management Console server on z/OS.

**Related tasks**
- “Updating Management Console on z/OS” on page 20
  As updates for IBM Management Console for IMS and Db2 for z/OS (Management Console) become available, you can install the latest package by running the Management Console installation job.
- “Updating Management Console on z/OS using the IBM product repository” on page 21
  You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRE job.
- “Updating from a local Management Console repository on z/OS” on page 22
  You can install a Management Console package that is obtained through SMP/E by running the DYWZINS job. This job uses Installation Manager to install the package from the Installation Manager repository on your z/OS system.
- “Uninstalling Management Console from z/OS” on page 24
  You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

**Related reference**
- “Software requirements for z/OS” on page 14
  Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

---

**Starting the Management Console server on z/OS**

A Management Console user must create an administrator user profile by accessing the Management Console log in page as the first user. A user who has administrator privileges can define user IDs and passwords for other Management Console users.

**Before you begin**
- The DYWZSRV cataloged procedure must be copied from the SAMPLIB installed during the SMP/E process to your proclib, for example, USER.PRIVATE.PROCLIB. The DYWZSRV cataloged procedure name must also match the name specified in the DYWZRACF job. Therefore, if you want to use a different name for your Management Console start-up, you must modify the DYWZRACF job.
- Ensure that you use of the following web browsers:
  - Mozilla Firefox ESR 31 or later
  - Google Chrome 36 or later

**Procedure**

Complete the following steps to authorize Management Console to run as a started task:

1. Modify the DYWZSRV job for your environment by following the instructions in the comments of the DYWZSRV job.
2. Modify the DYWZRACF job for your environment by following the instructions in the comments of the DYWZRACF job.
3. Submit the DYWZRACF job and verify that it completes with a condition code of 0. If you see a condition code of 0, you have installed successfully.
4. To start Management Console, issue the command `START DYWZSRV` on the MVS console.
5. To log into Management Console, point your web browser to the following address:

```plaintext
<http or https>://<host name or IP address>:<port number>/imweb/common/login.html
```

where:

- `<http or https>`
  - Depends on whether HTTP or HTTPS ports are enabled through the properties that are in the DYWZINS job.

- `<host name or IP address>`
  - The name of the server that is hosting Management Console.

- `<port number>`
  - The port number that is specified in the properties that are in the DYWZINS job. The default port number for HTTP is 9080, and the default port number for HTTPS is 9443.

**Tip:** If Management Console is configured to use an HTTPS port, you might encounter a warning or error message about a self-signed certificate when you first access Management Console from a web browser. Management Console uses a self-signed SSL certificate to authenticate communication between your web browser and Management Console. You can confirm that the certificate is self-signed by IBM and bypass the warning message in your browser. You might also be able to permanently accept the warning messages by adding the certificate to your browser's trusted certificates, so that it does not display each time that you connect. For detailed information about handling certificate warnings, see the help for your web browser.

**Related concepts**
- “Management Console security” on page 5
  - Only authorized users can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to access z/OS systems. Management Console also provides secure communication between distributed clients and the z/OS systems that they are connected to.

**Related tasks**
- “Installing Management Console on z/OS” on page 16
  - You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

- “Updating Management Console on z/OS” on page 20
  - As updates for IBM Management Console for IMS and Db2 for z/OS (Management Console) become available, you can install the latest package by running the Management Console installation job.

- “Updating Management Console on z/OS using the IBM product repository” on page 21
  - You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRED job.

- “Updating from a local Management Console repository on z/OS” on page 22
  - You can install a Management Console package that is obtained through SMP/E by running the DYWZINS job. This job uses Installation Manager to install the package from the Installation Manager repository on your z/OS system.

- “Uninstalling Management Console from z/OS” on page 24
  - You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

**Related reference**
- “Software requirements for z/OS” on page 14
Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

**Updating Management Console on z/OS**

As updates for IBM Management Console for IMS and Db2 for z/OS (Management Console) become available, you can install the latest package by running the Management Console installation job.

**Before you begin**
Installation Manager version 1.8 or later must be installed on the z/OS system that Management Console is to be updated on.

**About this task**
You can use the Management Console installation job DYWZINS, to install the latest package from either of the following locations:

- The IBM-hosted product repository provides users access to the product updates available in IBM’s Electronic Fix Delivery system for all products installed using Installation Manager. This repository is kept current with the latest Management Console packages as they become available.
- A local Installation Manager repository on your z/OS system. To update from this repository, you must first install the update repository on your z/OS system using SMP/E.

To update Management Console on z/OS, you must use the following sample jobs:

<table>
<thead>
<tr>
<th>Job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYWZCRED</td>
<td>Stores your IBM ID and password in a secure storage file, which is required for accessing Management Console update packages in the IBM product repository. Running this job is not required if you are updating Management Console using a local copy of the update repository obtained through SMP/E rather than an update repository accessed from the IBM product repository.</td>
</tr>
<tr>
<td>DYWZINS</td>
<td>Updates Management Console by using Installation Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Recommendation:</strong> If you customized the DYWZINS job for a previous update or installation, migrate your customized options to the most recent version of the job.</td>
</tr>
<tr>
<td>DYWZRACF</td>
<td>Authorizes Management Console to run as an MVS started task.</td>
</tr>
<tr>
<td>DYWZSRV</td>
<td>Starts Management Console as an MVS started task. This procedure must be authorized to the STARTED class of your system authorization facility (SAF) settings. DYWZRACF is provided to authorize the procedure.</td>
</tr>
</tbody>
</table>

**Related tasks**
"Installing Management Console on z/OS" on page 16
You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

“Starting the Management Console server on z/OS” on page 18

A Management Console user must create an administrator user profile by accessing the Management Console log in page as the first user. A user who has administrator privileges can define user IDs and passwords for other Management Console users.

“Uninstalling Management Console from z/OS” on page 24

You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

Related reference

“Software requirements for z/OS” on page 14

Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

Updating Management Console on z/OS using the IBM product repository

You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRED job.

Procedure

1. Modify the DYWZCRED job for your environment by following the instructions in the comments of the DYWZCRED job.
2. Submit the DYWZCRED job and verify that it completes successfully.
   If the job is successful, the DYWZCRED job log typically contains lines that are similar to the following lines at the end of the log:

   The provided URL exists.
   Successfully saved the credential to the secure storage file.
   Authorization Information:
   Realm = "www-912.ibm.com:443/Credentials required to connect to the IBM download site. Enter IBM ID and password. @IBM@DLG
   @a href="https://www.ibm.com/account/profile?page=forgotuid">Forgot your IBM ID?</a>    
   @a href="https://www.ibm.com/account/profile?page=forgot">Forgot your password?</a>    
   IBM ID help and FAQ</a>
   Scheme = "BASIC"
   User Name = "<myIBMID>
   User Password = "******"

   Troubleshooting tip: If the credential was present in the secure storage file before you ran DYWZCRED, the following message is given at the end of the job log:

   In this case, the IBM service repository URL for Management Console that you are trying to add to the secure storage file already exists in the secure storage file and is valid.

3. Stop the Management Console server by issuing the STOP DYWZSRV command on the MVS console.
4. Modify the DYWZINS job for your environment by following the instructions in the comments of the DYWZINS job.
5. Submit the DYWZINS job.
6. Submit the DYWZINS job and verify that it completes with a condition code of 0.

To view the Management Console license information, see IBM Software license agreements.
If the installation is successful, the DYWZINS job log typically contains the following lines at the end of the log:

```
Cleaning up saved files.
Validating eclipse configuration for IBM Management Console for IMS and DB2 for zOS
Updated to com.ibm.imac_1.1.0.yyyymmdd_hhmm to the /usr/lpp/IBM/mgmtconsole/v110 directory.
```

You can find the job log in the logs sub-directory of the location where Installation Manager stores run time data. For example, the location might be /usr/lpp/InstallationManager/appdata/logs.

7. To start Management Console, issue the `START <ProcName>` command on the MVS console, substituting the name of the Management Console start-up cataloged procedure for `<ProcName>`. The default name of the Management Console start-up cataloged procedure is DYWZSRV.

**Note:** You will not need to run the DYWZRACF job if you have submitted it previously and there have been no changes to the DYWZSRV job since it was run.

**Related tasks**

- “Installing Management Console on z/OS” on page 16
  You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

- “Starting the Management Console server on z/OS” on page 18
  A Management Console user must create an administrator user profile by accessing the Management Console log in page as the first user. A user who has administrator privileges can define user IDs and passwords for other Management Console users.

- “Updating Management Console on z/OS using the IBM product repository” on page 21
  You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRED job.

- “Updating from a local Management Console repository on z/OS” on page 22
  You can install a Management Console package that is obtained through SMP/E by running the DYWZINS job. This job uses Installation Manager to install the package from the Installation Manager repository on your z/OS system.

- “Uninstalling Management Console from z/OS” on page 24
  You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

**Related reference**

- “Software requirements for z/OS” on page 14
  Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

**Updating from a local Management Console repository on z/OS**

You can install a Management Console package that is obtained through SMP/E by running the DYWZINS job. This job uses Installation Manager to install the package from the Installation Manager repository on your z/OS system.

**Before you begin**

Ensure that the SMP/E installation process for Management Console has completed successfully.

**Procedure**

1. Modify the DYWZCOPY job for your environment by following the instructions in the comments of the DYWZCOPY job.
If you already have a ZFS or HFS file system where you want to copy the Management Console repository, comment out the CREATE step.

2. Run the DYWZCOPY job.

The DYWZCOPY job makes the Management Console repository accessible to Installation Manager, by completing the following actions:
   a. Allocates and mounts a z/OS File System (zFS) or Hierarchical File System (HFS)
   b. Copies and combines the separate parts of the Management Console repository into the zFS or HFS file system, from the data set where SMP/E placed it.
   c. Sets permissions on the Management Console repository.

3. Modify the DYWZINS job for your environment by following the instructions in the comments of the DYWZINS job:
   • Keep the same -installationDirectory variable value as the original installation.
   ```
   installationDirectory /usr/lpp/IBM/mgmtconsole/v110 +
   ```
   • Keep the same path for the -repositories variable value as the original installation, and update the name of the zip file.
   ```
   -repositories /usr/lpp/InstallationManagerRepository/HDYW110/+ mgmtconsoleUpdate.zip +
   ```

4. Stop the Management Console server by issuing the STOP DYWZSRV command on the MVS console.

5. Submit the DYWZINS job.

6. Verify the output to ensure that the installation is successful. If the installation is successful, the DYWZINS job log typically contains the following lines at the end of the log:
   ```
   Cleaning up saved files.
   Validating eclipse configuration for IBM Management Console for IMS and DB2 for zOS
   Updated to com.ibm.imac_1.1.0.yyyymmdd_hhmm to the
   /usr/lpp/IBM/mgmtconsole/v110 directory.
   ```
   You can find the job log in the logs sub-directory of the location where Installation Manager stores run time data. For example, the location might be `/usr/lpp/InstallationManager/appdata/logs`.
   To view the Management Console license information, see IBM Software license agreements.

7. To start Management Console, issue the `START <ProcName>` command on the MVS console, substituting the name of the Management Console start-up cataloged procedure for `<ProcName>`. The default name of the Management Console start-up cataloged procedure is DYWZSRV.

Related tasks
“Installing Management Console on z/OS” on page 16
You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

“Starting the Management Console server on z/OS” on page 18
A Management Console user must create an administrator user profile by accessing the Management Console log in page as the first user. A user who has administrator privileges can define user IDs and passwords for other Management Console users.

“Updating Management Console on z/OS using the IBM product repository” on page 21
You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRED job.

“Uninstalling Management Console from z/OS” on page 24
You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

Related reference
“Software requirements for z/OS” on page 14
Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.

Uninstalling Management Console from z/OS

You can uninstall Management Console from z/OS by modifying and running the job DYWZUNI.

Before you begin
When you uninstall Management Console, you will lose your Management Console data and logs. Ensure that you copy any necessary data and logs to another location prior to running DYWZUNI to uninstall Management Console.

About this task
The DYWZUNI job (located in the SAMPLIB data set installed during the Management Console SMP/E installation process) uses Installation Manager to uninstall Management Console from z/OS.

Procedure
1. Modify the DYWZUNI job for your environment by following the instructions in the comments of the DYWZUNI job.
2. Submit the DYWZUNI job and verify that it completes with a condition code of 0. If you see a condition code of 0, you have uninstalled successfully. Verify that the Management Console install directory is empty and remove any files or directories that remain after the uninstall job has completed.

Related tasks
“Installing Management Console on z/OS” on page 16
You can install IBM Management Console for IMS and Db2 for z/OS (Management Console) on z/OS by modifying and running a collection of sample jobs. These jobs are provided in the SAMPLIB data set of the Management Console SMP/E installation. These jobs use Installation Manager to install Management Console in a z/OS UNIX System Services file system.

“Starting the Management Console server on z/OS” on page 18
A Management Console user must create an administrator user profile by accessing the Management Console log in page as the first user. A user who has administrator privileges can define user IDs and passwords for other Management Console users.

“Updating Management Console on z/OS” on page 20
As updates for IBM Management Console for IMS and Db2 for z/OS (Management Console) become available, you can install the latest package by running the Management Console installation job.

“Updating Management Console on z/OS using the IBM product repository” on page 21
You can configure the DYWZINS job to directly access the latest Management Console package from the IBM product repository. The DYWZINS job must authenticate with the IBM product repository by providing your IBM ID and password. The DYWZINS job accesses this information from a secure credentials file that you create by running the DYWZCRED job.

“Updating from a local Management Console repository on z/OS” on page 22
You can install a Management Console package that is obtained through SMP/E by running the DYWZINS job. This job uses Installation Manager to install the package from the Installation Manager repository on your z/OS system.

Related reference
“Software requirements for z/OS” on page 14
Before you install and configure IBM Management Console for IMS and Db2 for z/OS (Management Console), ensure that you review all of the software and user requirements to run Management Console.
Chapter 3. Configuring Management Console

After the IBM Management Console for IMS and Db2 for z/OS (Management Console) server is installed and running, you can configure Management Console to support IMSplex management, autonomic maintenance of IMS databases, and Db2 for z/OS administration.

Configuring Management Console for IMSplex management

Create a connection to your IMS Connect by adding an IMS Connect component and specifying the IMSplex name to begin accessing and managing your IMSplex.

Before you begin

You must have an IMSplex with the following address spaces:

**IMS Connect**
- IMS Connect must be accessible to the Management Console server via HTTP or HTTPS communication.
- The IMS Connect OM command HWSCSLO1 exit routine must be configured.

**IMS Operations Manager**
- Operations Manager is required to query, start, and stop resources in an IMSplex by using type-2 commands.

**IMS control region**
- Your IMS control region can be a DBCTL, DCCTL, or DBDC region.

Tip: Based on the connection definition, Management Console later issues calls to discover the resources to build the IMS resource view. IMS could be started, or a new IMS control region could be added later. Management Console will discover these resources when it builds the resource view.

About this task

After a connection to IMS Connect is created, you can view the status for various resources, start and stop the communication with most of these resources, update programs, transactions, databases and routing codes, and issue IMS commands that are supported by the Operations Manager API.

Procedure

To create a connection to your IMS Connect, log in to the web interface and click Help. Locate the topic Creating a connection to your IMS Connect to complete the configuration steps.

Related information

Configuring an IMSplex with CSL

Configuring Management Console for autonomic maintenance of IMS databases

You can configure IBM Management Console for IMS and Db2 for z/OS (Management Console) to interface with certain IBM Tools Base for z/OS components. These components enable autonomic monitoring and maintenance of IMS databases.

Before you begin

The following Tools Base components must be installed and operating in the IMS system that you want to manage with Management Console:
• IBM Tools Base Distributed Access Infrastructure for z/OS
  You must know the Distributed Access Infrastructure host name and port number to be able to define it to Management Console.
• IBM Tools Base IMS Tools Knowledge Base for z/OS
  You must know the IMS Tools Knowledge Base cross-system coupling facility (XCF) group name to be able to define it to Management Console.
• IBM Tools Base Autonomics Director for z/OS
  You must know the XCF group name of the IMS Tools Knowledge Base server that provides access to the Autonomics Director repository.

These components are included with the SMP/E installation of Tools Base.

For more information about these components, see Tools Base for z/OS on IBM Knowledge Center.

For help with configuring these components, use the Deployment Assistance tab on the Management Console Environments page to see interactive steps.

About this task

By defining these Tools Base components to Management Console, you can view IMS database exceptions, view sensor data charts, and manage autonomic settings, among other capabilities.

For more information about the features that these components enable, see the Components overview topic in the Management Console help. To open this topic, hover over the help icon for the Components table on the Environments page and click Learn more.

Procedure

1. On the Environments page in Management Console, add an environment for the IMS system that you want to manage with Tools Base autonomic features. To add an environment, click Add Environment, enter a name for the environment, and click Save.
2. Add the following components to the Components table:
   a. Distributed Access Infrastructure
   b. IMS Tools Knowledge Base
      After you add IMS Tools Knowledge Base to the Components table, click Discover to populate Management Console with IMS resources from the IMS Tools Knowledge Base input repository.
   c. Autonomics Director (for IMS)

Extending Management Console with IMS Tools products

To extend the capabilities of IBM Management Console for IMS and Db2 for z/OS (Management Console) with the extensions provided by IMS Tools products, you must complete additional configuration tasks that are required for each extension.

Topics:
• “Viewing DBD and PSB maps in Management Console” on page 26

Viewing DBD and PSB maps in Management Console

After you install and configure the DBD/PSB Map Viewer, the IMS Library Integrity Utilities extension for Management Console, you can view a graphical visualization of a database structure map, program
specifications, the DBD and PSB macro source, and the DBD and PSB XML document in Management Console.

**Before you begin**

In addition to the software requirements for Management Console, this extension requires either of the following products to be installed and configured:

- IMS Database Solution Pack Version 2 Release 1 or later
- IMS Fast Path Solution Pack Version 1 Release 3 or later

The solution pack must contain IMS Library Integrity Utilities Version 2 Release 2 or later.

**Procedure**

1. Install and configure the extension on z/OS by completing the instructions in the topic "Setting up the DBD/PSB Map Viewer" in **IMS Database Solution Pack: Overview and Customization** or in **IMS Fast Path Solution Pack: Overview and Customization**.

2. Configure the DBD Map Viewer through the Management Console web interface.
   
   Log in to the web interface and click **Help**. Locate the topic "Getting started with DBD/PSB Map Viewer" and complete the configuration steps.
   
   Each Management Console user must complete this step.

**Results**

When you finish these steps, you can view the graphical structure of the database on the **Resources** program specifications on the **Resources** page.

---

**Configuring Management Console for Db2 for z/OS administration**

You can configure IBM Management Console for IMS and Db2 for z/OS (Management Console) to interface with Db2 for z/OS. Db2 provides information about your data sharing groups, their members, and supported Db2 objects.

**Procedure**

1. On the **Environments** page in Management Console, add an environment for the Db2 for z/OS system that you want to manage. To add an environment, click **Add Environment** ( ), enter a name for the environment, and click **Save**.

2. Click **Add Component** and select **DB2 for z/OS**.

3. Enter the required information in the **DB2 for z/OS** panel and click **Save**.

4. Click **Discover** to populate Management Console with information about the Db2 data sharing group, its members, and supported Db2 objects.
Chapter 4. Managing autonomic IMS database evaluations

You can use the Autonomics page in IBM Management Console for IMS and Db2 for z/OS (Management Console) to schedule autonomic database evaluations and to designate which databases receive these evaluations.

Before you begin

Management Console accesses database evaluation settings by communicating with the IBM Tools Base Autonomics Director for z/OS (Autonomics Director) server. Therefore, the following prerequisites must be met:

- Autonomics Director must be installed. Autonomics Director automates common database administration tasks. For more information, see Tools Base Autonomics Director in the information center.
- Autonomics Director must be specified as a component on the Environments page in Management Console. Only users with administrator access can use the Environments page. The XCF group name of the Autonomics Director server is required.

About this task

You can use the IMS Autonomics page to manage the following settings:

- Schedules, which regulate when automatic database evaluations occur. For example, you can create a schedule to limit evaluations from occurring during your normal peak processing times.
- Monitor Lists, which are lists of databases that are eligible to receive automatic evaluations.

Procedure

Access the Autonomics page by clicking Autonomics > IMS in the Management Console menu.

You can use the help on the Autonomics page for more information about autonomies and for step-by-step guidance for managing schedules and monitor lists.
You can use IBM Management Console for IMS and Db2 for z/OS (Management Console) to find and view exceptions for a group of IMS databases.

This tutorial shows you how you can use Management Console to manage IMS databases that are relevant to you. Management Console provides a high-level overview for a group of IMS databases that helps you quickly find and view details about a database that might require action.

**Learning objectives**
By completing this tutorial, you will learn how to complete the following tasks:

- Create groups for the resources that you want to manage
- View the overall health for a group of IMS databases
- View the details about a database with an exception

**Tip:** Although this tutorial focuses on managing databases by exception, you can use Management Console and this tutorial learn how to manage other resources.

**Time required**
This tutorial takes approximately 45 minutes to complete.

**Prerequisites**
In addition to the software requirements for Management Console, this tutorial assumes that you have also installed and configured the following items:

- The Management Console server.
- IBM Tools Base Policy Services for z/OS for exception information.
  For more information about exceptions, see *Tools Base Policy Services* in the information center.
- IBM IMS Database Solution Pack for z/OS or IBM IMS Fast Path Solution Pack for z/OS for sensor data information.
  For more information about sensor data, see "Database Sensor" in *IMS Database Solution Pack for z/OS* documentation.

**Topics:**
- “Lesson 1: Organizing your view with the IMS databases that you frequently work with” on page 31
- “Lesson 2: Finding and identifying IMS database problems” on page 32
- “Lesson 3: Viewing an IMS database exception” on page 33

**Lesson 1: Organizing your view with the IMS databases that you frequently work with**

To help you manage a large number of IMS databases, you can organize them into groups by using the Resources page in IBM Management Console for IMS and Db2 for z/OS (Management Console).

**About this task**
The following lesson shows you how to create groups and add databases to those groups. Although this lesson focuses on databases, you can organize any type of resource that is available in your environment.
Procedure

1. After you log in to Management Console, click Resources in the Management Console menu.
2. Select Custom IMS Database Groups from the list of views.
   Custom IMS Database Groups is a customizable view where you can add and organize the databases that you frequently work with. By default, Custom IMS Database Groups does not contain any groups or resources until you add them.
3. To populate the Custom IMS Database Groups view, click Add Resources.
   Tip: You can also remove groups and resources from the Custom IMS Database Groups view. Select the group or resource that you want to remove and then click Remove Group or Database.
4. In the Add Resources window, click Create Group to create a group. You will add your databases to this new group.
   Groups not only help you organize related databases, but can also help you see the overall health of your databases by providing a summary table, which is described in the next lesson.
5. Enter a name for the group in the Create New Group window and then click OK.
   Specify a name that helps you identify the databases in the group.
   For example, you can name the group high-priority databases and then add all your high-priority databases to the group.
6. After you create a group, search for the databases that you want to include in the group by using the search bar in the Add Resources window.
7. To add the databases to the group that you created, complete the following steps:
   a) Select the group that you want to add the databases to.
   b) Select the databases from the search results.
   Tip: You can select multiple databases by pressing Ctrl + click.
   c) Click Add to add the selected databases to the group that you selected.
8. Optional: Add additional groups and databases to Custom IMS Database Groups.
   You can add as many groups and databases as you need.
9. Click OK after you finish adding groups to Custom IMS Database Groups.

Results

All the groups and databases are displayed on the Resources page. The next lesson discusses how you can use the groups that you have created to quickly determine the health of all the databases.

Lesson 2: Finding and identifying IMS database problems

After you create a group, you can select it to view a summary table for the databases in that group. A summary table shows the overall health of those databases, the total number of exceptions for all the databases in the group, and other statistical information about the databases in the group.

Procedure

1. On the Resources page, click a group.
   A summary table is displayed.
   For databases, the summary table displays the following information:
   • Database type
   • Overall health of each database
   • Number of critical, severe, and warning exceptions
• Number of recommendations
• Number of reports

The first line of the summary table displays the total counts for each statistic.

The Overall column indicates whether a database has a critical, severe, warning, or no exception. Recommendations are actions that are provided by IBM Tools Base Autonomics Director for z/OS that can resolve exceptions in most cases.

2. Scan the summary table to identify any potential problems within the group.

A potential problem, for example, could be a database with a critical exception. By scanning the Overall column, you can quickly identify a database with the critical exception and then drill down into that database to view the exception.

What to do next
After scanning through the summary table, assume that you did find an exception for a database. The next lesson discusses how you drill down into a database to view more information and possible actions.

Lesson 3: Viewing an IMS database exception

When you find an exception for one of the IMS databases in the summary table, you can drill down into the database from the summary table. You can then view the exception and other statistical information about the database.

Procedure

1. Double-click a database in the summary table to view more information about it.

IBM Management Console for IMS and Db2 for z/OS displays an informational dashboard that includes the following widgets:

Summary
If the selected resource is a HALDB or DEDB database, a summary table provides statistics about the overall health of the partitions or areas that are in that database.

Properties
Lists database characteristics, such as the database type and the storage access method.

Exceptions
Displays exceptions, which are database health problems that are detected during policy evaluations for the selected database.

Reports
Lists reports that are associated with the selected resource. These reports are generated by certain IMS Tools products.

Space Use, Optimization, and Fragmentation
Display historical charts of sensor data, which are statistics about database characteristics.

The widgets that are displayed for each type of resource can vary depending on what information is applicable to the resource.

2. Use the Exceptions widget to view the exceptions that a database is experiencing.

A number that indicates the total number of exceptions for the database is displayed next to the title of the Exceptions widget.

a) Click the severity name to show the exceptions that are within that severity group.

A number next to the severity name indicates the number of exceptions that are within that severity group.

b) Hover over the exception to view the IBM Tools Base Policy Services for z/OS rule that triggered this exception.
c) Click the exception to view a help topic that details the exception and possible actions that you can take to resolve it.

Some exceptions also have an icon next to them that indicates that the exception has a recommended action ( ). These recommended actions are provided by IBM Tools Base Autonomics Director for z/OS, and if completed, will resolve the exception in most cases.

**Results**
The Exceptions widget is one of several widgets that can help you manage a database, a group of databases, or other types of resources.

**Tip:** For additional information about a widget, click the Information icon in the title bar of the widget.
Chapter 6. Troubleshooting

Use these topics to diagnose and correct problems with IBM Management Console for IMS and Db2 for z/OS

Gathering diagnostic information

Before you report a problem with IBM Management Console for IMS and Db2 for z/OS (Management Console) to IBM Software Support, gather the appropriate diagnostic information.

Procedure

• Provide the following information for all Management Console problems:
  – A clear description of the problem and the steps that are required to re-create the problem.
  – All messages and Management Console log records that were issued as a result of the problem.

Management Console provides separate logs that provide diagnostic information. You can obtain the log that is written to the messages bar and the log that is written to the Management Console installation directory.

To obtain the log that is written to the messages bar, complete the following steps:
  1. Click the messages bar, which is located at the bottom of the Management Console interface. The log is expanded.
  2. Copy the contents of the log.
  3. Paste the contents into any text editor.

To obtain the log that is written to the Management Console installation directory, navigate to the following file:

<Management Console installation directory>\imac\log\LogFile.log

– Product release number and the number of the last program temporary fix (PTF) that was installed.
– The version of Management Console that you are using and the type and version of the operating system that you are using.

You can find the Management Console version number by clicking Help > About in the Management Console menu.

• For problems with the DBD/PSB Map Viewer, in addition to the diagnostic information for Management Console, provide the following information:
  – All messages that were written to the Messages tab.
  – Distributed Access Infrastructure log records, job logs, and dumps that were generated as a result of the problem.
  – A Load Module APAR Status report and a Load Macro APAR Status report.

You can generate these reports by running the Diagnostic Aid (FABLDIAG) program of IMS Library Integrity Utilities. For more information, see the topic “Diagnostics Aid” in the IMS Library Integrity Utilities User’s Guide.

– The DBD library data set or the PSB library data set.
– For graphical problems, a screen capture of the web browser.
Messages for Management Console

Use the information in these messages to help you diagnose and solve IBM Management Console for IMS and Db2 for z/OS (Management Console) problems.

**Message format**

Management Console messages adhere to the following format:

```
AIIACnnnxx
```

- **AIIC**
  Indicates that the message was issued by Management Console.
- **nnn**
  Indicates the message identification number.
- **x**
  Indicates the severity of the message:
  - **A**
    Operator intervention is required before processing can continue.
  - **E**
    An error occurred, which might or might not require operator intervention.
  - **I**
    The message is informational only.
  - **W**
    The message is a warning to alert you to a possible error condition.

Each message also includes the following information:

**Explanation:**
Explains what the message text means, why it occurred, and what its variables represent.

**User response:**
Describes whether a response is necessary, the appropriate response, and how the response will affect the system or program.

**Administrator response:**
If an administrator response is necessary, describes what the system administrator must do to continue operation and to recover from the problem.

<table>
<thead>
<tr>
<th>Message Code</th>
<th>Message Text</th>
<th>Explanation</th>
<th>User Response</th>
<th>Administrator Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIIAC0002E</td>
<td>The autonomies settings for the selected locale cannot be accessed.</td>
<td>Management Console cannot locate any reports for the selected resource in the IMS Tools Knowledge Base output repository.</td>
<td>Ask the Management Console administrator to define Autonomics Director as a component for the environment that contains this locale. If you receive this message after reports were recently stored in the IMS Tools Knowledge Base output repository, click Synchronize on the Resources page.</td>
<td>On the Environments page, select the environment that contains this locale and add an entry for Autonomics Director to the Components table.</td>
</tr>
<tr>
<td>AIIAC0003I</td>
<td>No reports are available.</td>
<td>You can configure participating IMS Tools products to store reports in the IMS Tools Knowledge Base output repository.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Explanation**
Exception messages cannot be retrieved because the Autonomics Director server is inaccessible. This connection failure can occur for the following reasons:

- The Autonomics Director server is not running.
- The Autonomics Director components entry on the Environments page is not valid.

**User response**
- Verify that the Autonomics Director server is running.
- Ask the Management Console administrator to validate the Autonomics Director component for the environment. The environment name is provided in the Properties widget.

**Administrator response**: On the Environments page, select the environment, and then select the Autonomics Director entry in the Components table and click Validate. If the validation fails, edit the entry and specify a valid XCF group name.

**AIIAC0006I** Exception messages will not be retrieved because Autonomics Director is not defined as a component.

**Explanation**: Exception messages will not be retrieved for the selected resource because Autonomics Director is not defined as a component for the environment that this resource belongs to.

**User response**: If Autonomics Director is installed, ask the Management Console administrator to define an Autonomics Director component for the environment. The environment name is provided in the Properties widget.

**Administrator response**
On the Environments page, select the environment and add an entry for Autonomics Director to the Components table.

If Autonomics Director is not installed, see the installation instructions in the Program Directory for IBM Tools Base for z/OS V01.04.00.

**Feature**: Autonomic maintenance of IMS databases

**AIIAC0008I** No sensor data was generated for this chart.

**Explanation**: Sensor data is generated by utilities that run the DB Sensor component. This component is included in the IMS Database Solution Pack and the IMS Fast Path Solution Pack. If Autonomics Director is defined as a component for the environment, you can run DB Sensor utilities on demand or as part of automated database evaluations.

**User response**
Use DB Sensor utilities to collect sensor data and store it in the IMS Tools Knowledge Base Sensor Data repository.

If Autonomics Director is defined as a component, you can use Management Console to collect sensor data with either of the following actions:

- Run on-demand sensor data collection by clicking Menu in the Exceptions widget and selecting Schedule Sensor or Evaluation Job.
- Designate this resource for automated database evaluations by adding it to a monitor list. As automated evaluations occur, sensor data for this resource is stored in the IMS Tools Knowledge Base Sensor Data repository, and the charts are populated with that data.

To access your monitor lists, click Manage > Autonomics in the Management Console menu, and then click the Monitor List tab.

**AIIAC0010I** The sensor or evaluation job cannot run because the database is not specified in the monitor list.

**Explanation**: The database must be added to the monitor list before autonomic monitoring and maintenance can be run against the database.

**System action**: Processing continues. Management Console does not submit the autonomic job.

**User response**: Add the database to the monitor list.

**AIIAC0011E** The latest exception data cannot be retrieved for the resources in the following locales: locales

**Explanation**
The Autonomics Director server that runs evaluations on these locales is inaccessible. This connection failure can occur for the following reasons:

- The Autonomics Director server is not running.
- The Autonomics Director component entry on the Environments page is invalid.
- The Distributed Access Infrastructure server that accesses to the Autonomics Director server is not running.
- The Distributed Access Infrastructure connection entry on the Environments page is invalid.

**User response**: Verify that the Autonomics Director and Distributed Access Infrastructure servers are running.

**Administrator response**: Validate the Autonomics Director and Distributed Access Infrastructure entries.
on the **Environments** page. If the validation fails, edit the entries in the **Connections** or **Components** table.

**AIIAC0012I** Exception data is not retrieved because Autonomics Director is not defined as a component.

**User response:** If Autonomics Director is installed, ask the Management Console administrator to define Autonomics Director as a component on the **Environments** page.

**Administrator response**
If Autonomics Director is installed, add an entry for Autonomics Director to the **Components** table on the **Environments** page.

If Autonomics Director is not installed, see the installation instructions in the Program Directory for IBM Tools Base for z/OS, GL10-8810. To see the tasks for configuring Autonomics Director after SMP/E installation is complete, see Tools Base Autonomics Director on IBM Knowledge Center.

**IQEO0000E** A Java™ stack trace has been generated. The stack trace is: **trace**

**Explanation:** A serious error has occurred with the IMSplex management feature and a Java stack trace has been generated that contains information about the Java Virtual Machine at the time of the error.

**Administrator response:** Save the stack trace and restart the Management Console server. If the problem occurs again, contact IBM Software Support.

**IQEO0001E** A protocol error prevented a socket connection from being created. **Protocol message:** **message**

**Explanation:** A communication protocol error interrupted a socket connection to IMS Connect.

**User response:** Try your action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Examine the enclosed message to determine if the error is the result of a system configuration problem. If not, restart the Management Console server. If the problem continues to occur, contact IBM Software Support.

**IQEO0002E** A connection implementation error prevented a connection from being created. **Message:** **message**

**Explanation:** An IMSplex connection error interrupted a connection while it was being created.

**User response:** Try your action again. If the problem continues to occur, contact your administrator.

**IQEO0003E** A connection error prevented the request from being completed. **Message:** **message**

**Explanation:** A connection error interrupted a connection while a request to IMS Operations Manager was being processed.

**User response:** Try your action again. If the problem continues to occur, contact your administrator.

**IQEO0004E** The resource bundle cannot be found, or a resource is missing from a resource bundle. **Message:** **message**

**Explanation:** A file or part of a file is missing or corrupted in Management Console that is related to IMSplex management.

**User response:** Contact your administrator.

**Administrator response:** Reinstall Management Console.

**IQEO0005E** A property for an IMSplex member is invalid. **Message:** **message**

**Explanation:** A property value for an IMSplex member did not match the list of valid properties in the communication protocol.

**User response:** Try your previous action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Restart the Management Console server.

**IQEO0006E** An IMS Connect communication error occurred. **Message:** **message**

**Explanation:** The IMS Connect host was not reachable or the connection was stopped.

**User response:** Contact your administrator.

**Administrator response:** Examine the enclosed message to determine if additional troubleshooting is required. Typically, this problem is caused by a network connection error between the Management Console server and IMS Connect. If the network connection is restored and this error continues to occur, restart the Management Console server.

**IQEO0007E** A command was returned with an error. The command could not be executed. **Command:** **Cmd** **Connection:** Cnc **Return code:** Iconrc, **Message:** **message**
**reason code: Iconrsn, OM return code: Omrc, OM reason code: Omrsn, OM reason message: Ommsg, OM reason text: Omrsntxt**

**Explanation**
A command was successfully sent, but an error code was returned. In the message text:

**Cmd**
The original command.

**Cnc**
The name of the connection that the command was sent on.

**Iconrc**
The return code from IMS Connect.

**Iconrsn**
The reason code from IMS Connect.

**Omrc**
The return code from IMS Operations Manager.

**Omrsn**
The reason code from IMS Operations Manager.

**Ommsg**
An enclosed message passed on by IMS Operations Manager.

**Omrsntxt**
Enclosed message text passed on by IMS Operations Manager.

**User response:** Troubleshoot the IMS Connect, IMS Operations Manager, or IMS system that generated the underlying error.

**Administrator response:** Restart the Management Console server.

**IQEO0008E** A property for an application program member is invalid. Message: message

**Explanation:** A property value for an IMS application program (PSB) member did not match the list of valid properties in the communication protocol.

**User response:** Try your previous action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Restart the Management Console server.

**IQEO0009E** An invalid argument was used. Message: message

**Explanation:** The argument indicated in the enclosed message is invalid with the IMS command.

**User response:** If this is an automatically generated command, try your previous action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Restart the Management Console server.

**IQEO0010E** A property for a transaction is invalid. Message: message

**Explanation:** A property value for an IMS transaction did not match the list of valid properties in the communication protocol.

**User response:** Try your previous action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Restart the Management Console server.

**IQEO0011E** An invalid argument was used. Message: message

**Explanation:** The argument indicated in the enclosed message is invalid with the IMS command.

**User response:** If this is an automatically generated command, try your previous action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Restart the Management Console server.

**IQEO0012E** An error occurred while communicating with IMS Operations Manager. Message: message

**Explanation:** An internal error occurred in Management Console while an OM input or response message was being processed.

**User response:** Try your previous action again. If the problem continues to occur, contact your administrator.

**Administrator response:** Restart the Management Console server.

**IQEO0013E** An error occurred while accessing the local cache for the following environment: environment And the following IMSplex: IMSplex The following query failed: query.

**Explanation:** The cached data stored by Management Console was missing or corrupted. Some or all of the data for the indicated IMSplex might be inaccessible. In the message text:

**environment**
The name of the environment in which the Management Console encountered the cache error.
IMSplex
The name of the IMSplex affected by the error.

query
The query that failed when the Management Console attempted to retrieve the relevant data from the cache.

User response: Contact your administrator.

Administrator response: Restart the Management Console server. If the error occurs again, delete and re-create the indicated environment by selecting Configure > Environments on the banner menu.

IQEO0014E
A communication error occurred with connection type cnctype, for environment env and IMSPlex plex. Error return code: rc. Error reason code: rsn.

Explanation
A communication error occurred. Examine the enclosed error details for more information. In the message text:

cnctype
The connection type that encountered the error.

env
The name of the environment that encountered the error.

plex
The name of the IMSplex that encountered the error.

rc
The return code from OM.

rsn
The reason code from OM

rsnmsg
The reason message from OM.

rsntxt
The reason explanation from OM.

User response: Try your action again. If the error occurs again, troubleshoot the IMS Operations Manager address space that is returning the error.

Administrator response: Management Console is working normally. No action is required.

IQEO0016E
An error occurred while executing the following IMS Operations Manager command: cmd. The error return code is: rc. The reason code is: rsn. The reason message is: rsnmsg. The reason text is: rsntxt.

Explanation
A command was returned by IMS Operations Manager with an error. In the message text:

cmd
The original command that was sent to IMS Operations Manager.

rc
The return code from OM.

rsn
The reason code from OM

rsnmsg
The reason message from OM.

rsntxt
The reason explanation from OM.

User response: Try your last action again. If the problem continues to occur, contact your administrator.

Administrator response: Restart the Management Console server.

IQEO0018E

Explanation
Management Console encountered an internal error and stopped the operation for the IMSplex that was in progress.

User response: Try your last action again. If the problem continues to occur, contact your administrator.

Administrator response: Restart the Management Console server.

IQEO3001I
rsntax. Review the member completion codes.

**Explanation:** IMS Operations Manager returned a non-zero return code for a command. This problem can occur in many circumstances. Typically, it might occur because an IMSplex member that is registered to process commands was not accessible or did not complete the command at the time OM built the response message that was sent to the Management Console.

**User response:** Troubleshoot the Operations Manager or specific IMSplex member that encountered a problem while processing the command.

**Administrator response:** Management Console is working normally. No action is required.
This information was developed for products and services offered in the U.S.A.

This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

IBM, the IBM logo, and ibm.com® are trademarks or registered marks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at "Copyright and trademark information" at: http://www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions:

**Applicability:** These terms and conditions are in addition to any terms of use for the IBM website.

**Personal use:** You may reproduce these publications for your personal, noncommercial use provided that all proprietary notices are preserved. You may not distribute, display or make derivative work of these publications, or any portion thereof, without the express consent of IBM.

**Commercial use:** You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display these publications or any portion thereof outside your enterprise, without the express consent of IBM.

**Rights:** Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or implied, to the publications or any information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the publications is detrimental to its interest or, as determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

Privacy policy considerations

IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s Privacy Policy at http://www.ibm.com/privacy and IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at http://www.ibm.com/software/info/product-privacy.
Index

A
AIIAC0002E 36
AIIAC0004E 36
AIIAC0006I 37
AIIAC0008I 37
automatic database evaluations
managing 29
autonomics
settings 29

C
configuring
IMS autonomics 25
IMSplex management 25
Management Console 25
cookie policy 43

D
DBD Map Viewer 3
diagnostic information
gathering 35
documentation
accessing 5

E
exceptions 33
extending
DBD Map Viewer 26
extensions 3

F
features, See overview
firewall 5

G
group
resources 31
summary 32

H
hardware requirements 9, 14

I
IMS Connect 25
IMS control region 25
IMS Operations Manager 25
IMSplex
IMSplex (continued)
connection configuration 25
management 25
installation
prerequisites 9, 14
installing
Windows 10
z/OS 16

L
legal notices
cookie policy 43
notices 43
programming interface information 43
trademarks 43
links
non-IBM Web sites 45
logs 35

M
messages
AIIAC0002E 36
AIIAC0004E 36
AIIAC0006I 37
AIIAC0008I 37
IQEO0000E 38
IQEO0001E 38
IQEO0002E 38
IQEO0003E 38
IQEO0004E 38
IQEO0005E 38
IQEO0006E 38
IQEO0007E 38
IQEO0008E 39
IQEO0009E 39
IQEO0010E 39
IQEO0011E 39
IQEO0012E 39
IQEO0013E 39
IQEO0014E 40
IQEO0015E 40
IQEO0016E 40
IQEO0017E 40
IQEO0018E 40
IQEO3001I 40
overview 36
monitor list
settings 29
MySupport 5

N
notices 43
operating systems supported 9, 14
overview accessibility 7
architecture 3
extensions 3
features 1
product 1

Policy 31
prerequisites installation 9, 14
problems diagnostic information about 35
programming interface information 43

RACF 5
requirements hardware and software 9, 14
Resource page 31

schedules settings 29
screen readers and magnifiers 7
security 5
setting up 9
software requirements 9, 14
SSL 5
startup 11, 13, 18, 20–22
summary table 32
support required information 35

T

trademarks 43
troubleshooting 35
tutorial
Managing databases by exception 31

uninstalling
Windows 14
z/OS 24

Windows 11, 13

z/OS 18, 20–22